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Introduction — Who am I?

Tony UV (UcedaVelez), GSEC, CISM, CISA

OWASP Chapter Lead 2009

Founder, VerSprite

Former Sr. Director @ Equifax

SunTrust ETRM, SecureWorks, Tandberg, Morgan Stanley

Code Review, Security Architecture, Threat Modeling, Pen
Testing, Security Risk Management

Favorite Drink: Kamikazee

Favorite [Security] Quote: ‘Security is a Process’ (Schneier )

Personal Objective for OWASP-ATL:

= Become the most prolific security chapter in the Western
Hemisphere




Introduction - Why am I here ?

m Passion for security...
B Constructive & Destructive tendencies...

B Enjoy collaborative group think on emerging security
tools and research...

m Wife thinks I need a hobby other than playing Chutes &
Ladders with the kids...

B OWASP needed a kick in the pants
B Evangelizing security strategy




Introduction — Who are you?

You could be a ....
m Student

m Professor

Hm Pen Tester

B Developer

B Architect

B Security Engineer
B Risk Analyst

m [SO

m CISO

m CIO, CTO

B Social Butterfly




Introduction - Why should you be here?

m Passion for security...
B Constructive & Destructive tendencies...

B Enjoy collaborative group think on emerging security
tools and research

B Socializing is healthy...
B OWASP needs a kick in the pants

m Increase knowledge on new collaborative tools,
methodologies, and papers surrounding WebAppSec

B You don't get enough security at home
B An growing desire to learn and contribute.




OWASP GLOBAL
PERSPECTIVE




OWASP

The Open Web Application Security Project

B The Open Web Application Security Project (OWASP) is dedicated to
finding and fighting the causes of insecure software. The OWASP
Foundation is a 501c3 not-for-profit charitable organization that
ensures the ongoing availability and support for our work.

B Participation in OWASP is free and open to all.
Bl Everything here is free and open source.

B Main objectives: producing tools, standards and documentations
related to Web Application Security.

B Thousands active members, 82 local chapters in the world

B Millions of hits on www.owasp.ora
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OWASP?

B Provide free resources to the community

» Publications, Articles, Standards, e.q.
= OWASP Top 10
= OWASP Guide
= Testing Guide
» Testing and Training Software, e.q.
= WebGoat
= \WebScarab
= .NET Projects

» Local Chapters, Mailing Lists & Conferences
m Dual license model:

» Open Source Licenses
» Commercial License for Members




Release Quality Prajects Alpha Status Projects

Beta Status Projects

Inactive Projects

= Release guality projects are generally the level of quality of professional tools or documents.

= Projects are listed below.
Tools

PROTECT:

OWASP AntiSamy Java Project
an APl for validating rich HTML/CSS input from users without exposure to cross-site
scripting and phishing attacks (Assessment Criteria +1.0)

OWASP AntiSamy .NET Project
an AP for validating rich HTML/CSS input from users without exposure to cross-site
scripting and phishing attacks. (Assessment Criteria w1.0)

OWASP Enterprise Security APl (ESAPI) Project
a free and open collection of all the security methods that a developer needs to build a
secure web application. (Assessment Criteria v1.0)

DETECT:

OWASP Live CD Project
this CO collects some of the best open source security projects in a single
erwironment. YWeb developers, testers and security professionals can boot from this
Live CD and have access to a full security testing suite. (Assessment Criteria v1.0)
OWASP WebScarab Project
a tool for pedorming all types of security testing on web applications and web services
(Assessment Criteria v1.0)

LIFE CYCLE:

OWASP WehGoat Project
an online training environment for hands-on learning about application security
(Assessment Criteria v1.0)

Documentation

PROTECT:

OWASP Development Guide
a massive document covering all aspects of web application and web service security
[Assessment Criteria v1.0)

OWASP Ruby on Rails Security Guide W2
this Project is the one and anly source of infarmation about Rails security topics.
(Assessment Criteria v1.0)

DETECT:

OWASP Code Review Guide

a project to capture best practices for reviewing code. (Assessment Criteria v1.0)
OWASP Testing Guide

a project focused on application security testing procedures and checklists

(Agsessment Criteria v1.0)

OWASP Top Ten Project
an awareness document that describes the top ten web application security
wulnerahilities (Assessment Criteria v1.0)

LIFE CYCLE:

OWASP AppSec FAQ Project
FAQ covering many application security topics (Assessment Criteria v1.0)

OWASP Legal Project
a project focused an providing contract language for acquiring secure software
IAssessment Criteria w1.0)

OWASP Source Code Review for OWASP Projects
a wearkflow for OWYASE projects to incarporate static analysis into the Software
Developrent Life Cycle (SDLC). (Assessment Criteria v1.0)



o OWASP

The Open Web Application Security Project

BuildingGuide Top 10
Training

CLASP
Ajax

Conferences

: WebGoat
Orizon Build

.NET, Java Building our
Yours! brand
Chapters
Testing Guide Project
Webs b‘ incubator
ebScara ifiati Communi
Verification ty Wiki portal
Validation
Forums

Certification Blogs
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Agenda:

m CLASP
B OWASP Testing Guide
mOWASP in the ATL

m Special Announcement
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OWASP CLASP




What Is CLASP and How Do I Catch It?
B Not an STD spreading across OWASP events

B Comprehensive, Lightweight Application Security Process

B Addresses 7 key Ingredients
1.  Security Concepts,

Application Roles,

Activity Assessment,

Activity Implementation

Vulnerabilities,

o vk W

Use Cases,

/. Resources
B Integrates into existing enterprise processes:
B Software development
B Software assurance group
B Risk assessment team
B Takes a prescriptive approach, documenting activities that or%@mggt'@s

should be doinﬂ.Describe the OWASP methodologx



5 Levels of VIEWS & Resour

Concepts View (1)
Milestane: Undarstard how CLASP process componants interact and haw o apphy || thraugh Y.
Role-Based View (II)
Milestone: Create roles required by security-related project and ufilize them in I, IV and V.
» Activity-Assessment View (IIl)
Milestona: Assass 24 security-related CLASP activitias for suitability in 1.
Implementation Activity
|
Activity-Implementation View (IV)
Milestone: Parform subset of 24 security-relatad CLASP activitias saleded in .
Vulnerability View (V)
Milestone: Integrate salutions to problem types inta 111 and V.
Consequences Problem Types .
of unresoived 104 problem types are sub- Exposure Periods
yilnerabilities sumed under § high-lavel (by SDLC phases)
Categories
Risk Assessment Avoidance & Mitigation A & M Periods
Techniques [by SDLC phases)

ces

CLASP Resources

Basic Principles in
Application Security (all
Views)

Example of Basic Principle:
Input Validation (all Views)

Example of Basic-Principle
Violation: Penetrate-and-
Patch Model (all Views)

Core Security Services (all
Views; especially III)

Sample Coding Guideline
Worksheets (Views II, III &
IV) Note: Each worksheet
can be pasted into a MS
Word document.

System Assessment
Worksheets (Views III &
IV) Note: Each worksheet
can be pasted into a MS
Word document.

Sample Road Map: Legacy
Projects (View III)

Sample Road Map: New-
Start Projects (View III)

Creating the Process
Engineering Plan (View III)

Forming the Process
Engineering Team (View
III)

Glossary of Security Terms
(all Views)

Location

Resource A

Resource B

Resource C

Resource D

Resource E

Resource F

Resource G1

Resource G2

Resource H

Resource 1

Resource.‘lASP e e
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CLASP Use Cases

m Apply secure s
coding guidelines
to use cases in
web app

m Correlate use .m.:.:{w.m.
Ca Ses to : _¢LA$P Uze Cases
vulnerabilities Moot e

+« Table: component architecture
+« Diagram: security-related process flow

m Apply security T Ja: sepped o of et oid oo

+« Table: vulnerahility-related information

tOOIS againSt : 21'Ijrj:'E";'J'Eﬂ;'l""r.":'ﬂg:""E'I*'1:'‘'tj‘rTﬁ::ﬂlrlll:'rl!i::liﬁi-ln-,I:llamsm||:-1'---ulrm.r;ul:num.ng
. . » Categories of CLASP Problem Types
identified use

Apply CLASP Resources throughout the planning,
design, construction, and lestin g phases, as needed,

+ Additional CLASP Resources
+ CLASP Activity Assessment
« CLASP Activity Implementation

Y Write Security-
Related Source

Code

|CLASP Vulnerability Lexicon |

+ Consequences of breached security services

Cases




CLASP Problem Types

= CLASP idantifies 104 underlying problem iypes that form the basis of sacurily vulnerabilitias in application source coda.
An individual problem type in itsel is oftan not a security vulnerability; frequently it 1= a combination of problems that

creale a security conditiaon leading to 8 vulnerahility in the source code,

CLASP Lexicon
= CLASP divides the 104 problam types indo 5 high-level catagories. Each problem typs may have mare than one parant

m Comprehensive S )
(~220 defintions) 1 1

taxonomy of
vulnerability
definitions

Avoidance & Mitigation
The more successful the avoidance
and mitigation af wulnerability rool-
causes, the fewer and less severe

= will be the consequences of any

allampted sxploitation of
wulnerakilities in the application's
soUrce code,

A & M Period
Pariods when vulnerabilites can ba
avoided and mitigated through
improved sounce coding —

Aveld creating vulrerability
through securty-sware source
coding

Categories of Problam Types

=1 104 problem types are divided into five

high-lewal categories:

Ranga and Type Errors
Environmwanlal Proolems
Synchronization & Timing Errors
Protocal Errors

Genearal Logic Ermars

Exposure Period
Pariods whan vulnerabilites can ba
inachertently introduced into soaurce
code by developer — organized by

m Highly flexible
taxonomy enables
ease of use

organized by phases of SDLC. phases af SDLC.

Y

Consequences of Exploitable Vulnerabilities
can b fallures in hese Basic sacurily services:
- = Authorization (resource access coninol)
= Confidenfiality (of data or other resourcas)

Goal: Make security services invulnerable to altack

Alllacks wulnerabilitias in code,

= Aulhenticalion (idandity astablishment and inlegrity) ' ! | !
« Ayailability (denial of sarvice) whmh_ ara fm!urea in basic
+  Agoountabiliy p— SECUMLY SErVICES.
+ Mon-repudiation
I ’ P .
U SI n g to ay S Severity of Exploit Probability of Exploit Prerequisites for exploiter to
Indicates criticality of an Likelihood that a vulnerability will attack vulnerabilities in

exploitad vulnerability in applicalion's source code.

applicalion's sourca code,

result in 8 succassful exploits-
tion of application’s sourcs code,

existing suite of
static analysis tools

Risk Assessment

18




CLASP Summarized

B Stakeholders
» Read & understand “Concepts View”
» Read & understand “Role-Based View”

B Project manager
» Reads and understands “Activity-Assessment View”
» Determines applicable and feasible “Security Activities” to implement
» Ties stakeholder roles to “Security Activities”
» Facilitates “"Roles” to learn and execute “Security Activities”
» Measures progress and holds “Roles” accountable (Metrics)

m Roles (PM, Architect, Designer, Implementer, ...)

» Execute “Security Activities” leveraging automated tools and CLASP
& Organization knowledge base (Vulnerability Lexicon and other
Resources)

©




OWASP TESTING GUIDE




What Is the OWASP Testing Guide?

M A puzzle piece...

Honeycomb

Threat Agents

Business Impacts

Business
Impact

Vulnerabilities

Vulnerability \

Countermeasures

- 4 » od ]
l .,.\ ’ -
_ ~ 'A
Asset Countermeasure \

Attacks

Code Review
Guide

System Impacts

Building

Attack

S
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OWASP Testing Guide v3: Goals

® "OWASP Testing Guide", Version 3.0 Create a complete
new project focused on Web Application Penetration
Testing

® Published 11.2008

® Create a complete new project focused on Web
Application Penetration Testing

® Create a reference for application testing
® Describe the OWASP Testing methodology

OWASP 2




Testing Guide v3: Index

1. Frontispiece

2. IntrOdUCtion OWASP TESTING GUIDE
3. The OWASP Testing Framework

4. Web Application Penetration Testing

5. Writing Reports: value the real risk
Appendix A: Testing Tools
Appendix B: Suggested Reading

Appendix C: Fuzz Vectors

Appendix D: Encoded Injection




What's new?

B V2-> 8 sub-categories (for a total amount of 48 controls)
m V3 210 sub-categories (for a total amount of 66 controls)
B 36 new articles!

W Information Gathering

m Config. Management Testing
B Business Logic Testing

B Authentication Testing

B Authorization Testing

B Session Management Testing
m Data Validation Testing

B Denial of Service Testing

B \Web Services Testing

B Ajax Testing

B Encoded Appendix

B Information Gathering

W Business Logic Testing

B Authentication Testing

W Session Management Testing
m Data Validation Testing

m Denial of Service Testing

m \Web Services Testing

B Ajax Testing




The OWASP Testing Framework

B The problem of insecure software: companies next challenge

B Why OWASP?

» “It's impossible to underestimate the importance of having this guide available in
a completely free and open way"— Jeff Williams (OWASP Chair)

B Principles of Testing: comparing the state of something against a set of
criteria defined and complete.

» We want security testing not be a black art
B Testing Techniques:
» Manual Inspections & Reviews

» Threat Modeling
» Code Review

» Penetration Testing




T
The OWASP Testing Framework

Phase 1: Before Development Begins

Before application development has started:

Bl Test to ensure that there is an adequate
SDLC where security is inherent.

Bl Test to ensure that the appropriate policy S ~
and standards are in place for the
development team.

Bl Develop Measurement and Metrics Criteria




The OWASP Testing Framework

Phase 2: During Definition and Design
Before application development has started:

B Security Requirements Review: | —

» User Management (password reset etc.), Authentication,
Authorization, Data Confidentiality, Integrity,
Accountability, Session Management, Transport Security, -
Privacy

B Design an Architecture Review -
B Create and Review UML Models

» How the application works
B Create and Review Threat Models

» Develop realistic threat scenarios




T
The OWASP Testing Framework

Phase 3: During Development
B Code Walkthroughs:

» high-level walkthrough of the code where
the developers can explain the logic and
flow.

B Code Reviews:

» Static code reviews validate the code
against a set of checklists:

= CIA Triad
= OWASP Top10, OWASP Code Review
= Sox, ISO 17799, etc...




T
The OWASP Testing Framework

Phase 4: During Deployment

Bl Application Penetration Testing
» Focus of this guide =
B Configuration Management Testing

» The application penetration test should
include the checking of how the
infrastructure was deployed and secured. e —d

Phase 5: Maintenance and Operations

B Conduct operational management reviews
B Conduct periodic health checks
B Ensure change verification




Web Application Penetration Testing

B What is a Web Application Penetration Testing?

» The process involves an active analysis of the application for any
weaknesses, technical flaws or vulnerabilities

B What is a vulnerability?
» A weakness on a asset that makes a threat possible

B Our approach in writing this guide
» Open
» Collaborative

Bl Defined testing methodology
» Consistent
» Repeatable
» Under quality

OWASP e 30




Black Box vs. Gray Box

Black Box » The penetration tester does not have any information
about the structure of the application, its components
and internals

Gray Box - The penetration tester has partial information about the
application internals. E.g.: platform vendor, sessionID
generation algorithm

~

1

White box testing, defined as complete knowledge of the application internals,
Is beyond the scope of the Testing Guide and is covered by the OWASP Code
Review Project

- J

OWASP e -




Testing Model

B We have split the set of tests in 8 sub-categories (for a
total amount of 48 controls):

» Information Gathering

» Business logic testing

» Authentication Testing

» Session Management Testing
» Data Validation Testing

» Denial of Service Testing

» Web Services Testing
A1AX Testina

In the next slides we will look at a few examples of
tests/attacks and at some real-world cases ....

OWASP e -




Information Gathering

B The first phase in security assessment is of course focused on
collecting all the information about a target application.

Bl Using public tools it is possible to force the application to leak
information by sending messages that reveal the versions and
technologies used by the application

Bl Available techniques include:
» Raw HTTP Connections (netcat)
» The good ol' tools: nmap, amap, ...
» Web Spiders
» Search engines ("Google Dorking”)
» SSL fingerprinting
» File extensions handling
» Backups and unreferenced files

OWASP e 33




Information Gathering (cont.)

» Application Fingerprint
Knowing the version and type of a running web server allows testers to determine

known vulnerabilities and the appropriate exploits to use along the tests. Netcat is the
tool of choice for this very well known technique

$ nc 216.48.3.18 80

HEAD / HTTP/1.0

HTTP/1.1 200 OK

Date: Mon, 16 Jun 2003 02:53:29 GMT

Server: Apache/1.3.3 (Unix) (Red Hat/Linux)
Last-Modified: Wed, 07 Oct 1998 11:18:14 GMT
ETag: "1813-49b-361b4dfe6"

Accept-Ranges: bytes

Content-Length: 1179

Connection: close

Content-Type: text/html

...But what if the “Server:” header is obfuscated ?

OWASP e ”




Information Gathering (cont.)

Other hints can be found by sending the server a malformed request, for
instance a “GET / HTTP/3.0"

HTTP/1.1 400 Bad Request

Date: Sun, 15 Jun 2003 17:12: 37 GMT
Server: obfuscated :P

Connection: close [ Apache 1.3.23 ]
Transfer: chunked

Content-Type: text/HIML; charset=i1s0-8859-1

HTTP/1.1 505 HTTP Version Not Supported
Server: obfuscated :P

Date: Mon, 16 Jun 2003 06:04: 04 GMT .
Content-length: 140 [Netscape Enterprise 4.1 ]

Content-type: text/HTML
Connection: close

HTTP/1.1 200 OK

Server: obfuscated :P

Content-Location: http://target.com/Default.htm
Date: Fri, 01 Jan 1999 20:14: 02 GMT

Content-Type: text/HTML [IIS 5.0 ]
Accept-Ranges: bytes

Last-Modified: Fri, 01 Jan 1999 20:14: 02 GMT
ETag: W/e0d362a4c335bel: ael

Content-Length: 133

...But what if the application simply returns a generic error page ? ]
35
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Information Gathering (cont.)

The good news is that each server has a favorite way to order

headers !

Here are the results for some common web servers when responding
toa “"HEAD / HTTP/1.0" command:

Apache 1.3.23 IIS 5.0 Netscape Enterprise 4.1 [SunONE 6.1
Date Server Server Server

Server Content-Location [Date Date
Last-Modified Date Content-Type Content-Length
ETag Content-Type Last-Modified Content-Type

Accept-Ranges

Accept-Ranges

Content-Length

Last-Modified

Content-Length

Last-Modified

Accept-Ranges

Connection:

ETag

Connection

Content-Type

Content-Length
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T
Business logic testing

In this phase, we look for flaws in the application business logic rather
than in the technical implementation. Areas of testing include:

B Rules that express the business policy (such as channels, location,
logistics, prices, and products)

B Workflows that are the ordered tasks of passing documents or data from
one participant (a person or a software system) to another

One of the most common results in this step of the analysis are flaws in the
order of actions that a user has to follow: an attacker could perform them in
a different order to get some sort of advantage

This step is the most difficult to perform with automated tools, as it
requires the penetration tester to perfectly understand the business
logic that is (or should be) implemented by the application

- J
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T
Business logic testing: example

FlawedPhone, a mobile phone operator, has launched a webmail+SMS service:

» New customers, when buying a SIM card, can open a free, permanent
webmail account with the flawedphone.com domain

» The webmail account is preserved even if the customer “transfers” the SIM
card to another telecom operator

» However, as long as the SIM card is registered to FlawedPhone, each time
an email is received an SMS message is sent to the customer

» The SMS application checks that the target phone number is a legitimate
customer from its own copy of the FlawedPhone customers list

Nice, but what about the list synchronization ?! ]
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Business logic testing

FlawedPhone was soon targeted by a fraud attack

» The attacker bought a new FlawedPhone SIM card

» The attacker immediately requested to transfer the SIM card to another
mobile carrier, which credits 0.05 € for each received SMS message

» When the SIM card was “transferred” to the new provider, the attacker then
started sending thousands of emails to her FlawedPhone email account

» The attacker had a 6-8 hours window before the email+SMS application had
its list updated and stopped delivering messages

» By that time, the attacker had ~50-100 € in the card, and proceeded to sell
it on eBay

4 )

All FlawedPhone systems worked as expected, and there were no bugs
in the application code. Still, the logic was flawed.

©




Authentication testing

- ™
Testing the authentication scheme means understanding how the application
checks for users' identity and using that information to circumvent that

mechanism and access the application without having the proper credentials
- Y,

Tests include the following areas:
» Default or Guessable Accounts
« Brute-force
« Bypassing Authentication
« Directory Traversal / File Include
« Vulnerable "Remember Password” and Password Reset
« Logout and Browser Cache Management




Session management testing

- A
Session management is a critical part of a security test, as every application

has to deal with the fact that HTTP is by its nature a stateless protocol.
Session Management broadly covers all controls on a user from
authentication to leaving the application

Tests include the following areas:
= Analysis of the session management scheme
= Cookie and session token manipulation
= EXxposed session variables
= Cross Site Request Forgery
= HTTP Exploiting




Example: Cross Site Request Forgery

application he/she is currently logged into

[Test if it is possible to force a user to submit an undesirable command to the]

» Also known as “Session Riding” or “Sea Surf”

>

Exploits trust between the site and the user (different from XSS which
exploits trust between user and site)

A quite old type of attack, whose impact has always been
underestimated

It relies on the fact that browsers automatically send information used
to identify a specific session

Applications that allow a user to perform some action without requiring
some unpredictable parameter are likely to be vulnerable

... That means a lot of applications!

All it takes is to trigger the victim to follow a link (e.g.: by visiting an
attacker-controlled site) while he/she is logged into the application

©




T
Example: Cross Site Request Forgery (cont.)

B trade.com is an online trading company

m trade.com uses an “Uber-paranoid triple-factor”™ authentication scheme,
but do}gs not want to bother users with confirmations, since traders need
to act fast!

m A simple website and some social engineering will do the job

<html>
<title>l am a very evil HTML page... visit me ! :)</title>
<body>

<img src=”https:IItrade.cr@nsfer?eu=90000&to=1234 idth="0" height="0">
</body>
</html>

The link triggers
a fund transfer

The image is
not visible




-
Data validation testing

In this phase we test that all input is properly sanitized before being
processed by the application, in order to avoid several classes of
attacks

B Cross site scripting

Test that the application filters JavaScript code that might be executed by the
victim in order to steal his/her cookier

B HTTP Methods and XST
Test that the remote web server does not allow the TRACE HTTP method

B SQL Injection
Test that the application properly filters SQL code embedded in the user input

B Other attacks based of faulty input validation...
» LDAP/XML/SMTP/QOS injection
» Buffer overflows

OWASP e 44




Testing Report: model

B The OWASP Risk Rating Methodology

» Estimate the severity of all of these risks to your business

» This is not universal risk rating system: vulnerability that is critical to one
organization may not be very important to another

B Simple approach to be tailored for every case
» standard risk model: Risk = Likelihood * Impact

B Step 1: identifying a risk
You'll need to gather information about:
» the vulnerability involved
» the threat agent involved
» the attack they're using
» the impact of a successful exploit on your business.




Testing Report: likelihood

H Step 2: factors for estimating likelihood

Generally, identifying whether the likelihood is low, medium, or high
is sufficient.

Threat Agent Factors:
» Skill level (0-9)
» Motive (0-9)
» Opportunity (0-9)
» Size (0-9)

Vulnerability Factors:
» Ease of discovery (0-9)
» Ease of exploit (0-9)
» Awareness (0-9)
» Intrusion detection (0-9)




Testing Report: impact

B Step 3: factors for estimating impact

Technical impact:
» Loss of confidentiality (0-9)
» Loss of integrity (0-9)
» Loss of availability (0-9)
» Loss of accountability (0-9)

Business impact:
» Financial damage (0-9)
» Reputation damage (0-9)
» Non-compliance (0-9)
» Privacy violation (0-9)




Testing Report: value the risk
Bl Step 4: determining the severity of the risk

Thredt agent factors Wulmerability factors
: . . . Ease of Ease of Intrusion
Skill lenel Motive Opportunity  |Size discovery exploit AWArSNSss detection
5 2 7 1 3 & ? 2
Cverdll likelihood=4.375 (MEDIUNM)

Technical Impact Business Impact
Loss of Loss of Loss of Loss of Financial Reputation  |Non- Privacy
confidentiality  [integrity avaiability |accountability  |[damage domage compliance  |[violation
@ 7 5 8 1 2 ] 5
Overdll technical impact=7.25 (HIGH) Cwverall business impact=2.25 (LOW)

B In the example above, the likelihood is MEDIUM, and the technical impact is

HIGH, so from technical the overall severity is HIGH. But business impact
is actually LOW, so the overall severity is best described as LOW as well.
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Testing Report: decide what to fix

B Step 5: Deciding What To Fix
As a general rule, you should fix the most severe risks first.

Some fix seems to be not justifiable based upon the cost of fixing
the issue but may be reputation damage from the fraud that could
cost the organization much more than implement a security control

M Step 6: Customizing Your Risk Rating Model
» Adding factors
» Customizing options
» Weighting factors




Writing Report

M 1. Executive Summary

M II. Technical Management Overview
M III Assessment Findings

H IV Toolbox

Ref.

Category Affected ltem Finding Comment/Solulion
Number

Authentication OWASP-AT- | Bypassing
Testing Q03 authentication
schema

CASP-AT- | Directons
004 trawversalffile
include

OWASP-AT- | Wulherakls

005 remember
e ord and
pwd reset

CwASP-AT- | Logout and

008 Browser Cache
Management
Testing

OWiASP- Session

SMA-001 Management

Session Schema

Manogement

Oy ASP- Sezsicn Token




How the Guide will help the security
industry

» A structured approach to the testing activities

Pen-testers - A checklist to be followed

.~ A'learning and training tool

Clients _ .
.~ A way to check the quality of the penetration tests they

buy

‘ : .~ Atool to understand web vulnerabilities and their impact
p

~
More in general, the Guide aims to provide a pen-testing standard that creates
a 'common ground' between the pen-testing industry and its client.

This will raise the overall quality and understanding of this kind of activity and
therefore the general level of security in our infrastructures

J

-
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What's next

B You should adopt this guide in your organization

Bl Continuously reprioritize

B OWASP Testing Guide next steps:
» Continuously improve the Testing Guide: it's a live document!
» Contribute to the new version
» Improve the client side testing
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Atlanta Chapter - What do we have to offer?

B Quarterly Meetings

m Local Mailing List

m Presentations & Groups

B Open forum for discussion

B Meet fellow InfoSec professionals

m Create (Web)AppSec awareness in Atlanta
W Local projects

B Beer Socials




Atlanta Chapter - OWASP Membership

m Using OWASP material?

Hm Join us and become member!
» Individual Supporter

» Organizational Supporter
» Atlanta OWASP Leadership Board

m Support OWASP to continue to provide unbiased:
» Tools
» Documentation
» Conferences
» Mailing Lists
http://www.owasp.org/index.php/Membershi
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OWASP Local Chapter Meetings 2009

B Next Meeting:

» Saturday, April 25t, 2009
= Filter Evasion Workshop
= Rob Regan, Presenter
= Location: GA Tech (Most likely Klaus Bldg)

B Meeting Program Formats
» Short OWASP intro
» Presentation on introduction topic
» Panel, workshop, round-table, presentation
» Sponsor acknowledgement
» Break for post meeting social

W Topics:
» Call for input!
» tonyuv@versprite.com owasp @) s




Atlanta Chapter- Sponsorship

m Local sponsors:
» Fortify, GA Tech (GTISC)

I_F!;IRTIFY“

INFORMATION SECURITY CENTER

m Call for additional sponsors
» Chapter meeting places & catering
» Support for local projects

B OWASP cannot recommend the use of products,
services, or recommend specific companies

» However, we can acknowledge our sponsors and their
contribution to the industry and OWASP
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Atlanta Chapter - Comm

m Keep up to date!

» OWASP Atlanta Chapter Page
(http://www.owasp.org/index.php/Atlanta Georgia)

B Subscribe to BE Chapter mailing list
» https://lists.owasp.org/mailman/listinfo/owasp-atlanta

m Post your (Web)AppSec questions/ comments

H Contribute to discussions!

» Join our own IRC channel on EfNet
= #owasp-atlanta
= Basicop
= manEfaces

" Src OWASP e o
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Atlanta Chapter - House Rules

B Free & open to everyone

B Language
» English preferred
» Native language: no problem!

Bm No vendor pitches or $ales presentations
m Respect for different opinions
m No flaming (including M$ bashing)

m 1 CISSP CPE for each hour of OWASP chapter meeting
m Sign Sheet & I'll e-mail scan: you claim CPE credits
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Case Study CFP

m OWASP Atlanta Case Study

» Leverage relationship between OWASP members & local Atlanta
based organizations

» Real world applications of OWASP tools & methodologies
» Company Incentive: Free FTEs

» Member Incentive: Do things in your profession/ field of study
other than theoretical analysis and compliance reports

» Proposed topics include:
= Static Analysis Case Study
= Threat Modeling Case Study
= Pen Testing Case Study

» For more information email: tonyuv@versprite.com

» Results to be shared amongst local chapter community and
other security groups in the ATL

» Results to be shared globally at other OWASP conferences
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SPECIAL EVENT ANNOUNCEMENT




Block your agendas for May 11-14
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the Biggest European AppSec event of the year
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2 fantastic key notes
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Ross Anderson
Professor in Security Engineering
University of Cambridge
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Bruce Schneier
Chief Security Technology Officer
BT
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3 tracks stuffed with
high quality topics and great speakers
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Day 1 - May 13, 2009
Track 3: Roorn 3

Registration and Coffee

Welcome to OWYASP AppSec 2009 Conference
Sebastien Deleersnyder, OWASF Foundation

Keynote

Ross Anderson, Professor in Secunty Engineening, University of Cambridge

OWWASP State of the Union
Dinis Cruz & Sebastien Delearsnyder, OWASP Foundation

Break - Expo - CTF

Mirage: building an application model made easy
(OWASE Orizon w 1.2

Faaolo Perego, Spike Reply

The Truth about Web Application Firewalls: What
the vendors do nat want you to know

Wendal Guglielmett! Henrique, Trustwave &
Sandro Gaucl, EnableSecuritys

Lunch - Expo - CTF
Refereed Paper Track

Speaker, Crganisation

Refereed Paper Track

Speaker, Organisation

Refereed Paper Track

Speaker, Organisation

Break - Expo - CTF

Refereed Paper Track

Speaker, Organisation

Panel Discussion

Moderator: thd , Panelists: thd

Refereed Paper Track 3

Speaker, Crganisation



Day 2 - May 14, 2009

Track 3: Room 3

Registration and Coffes
Keynote

Bruce Schneler, Thief Securnity Technology Officer, BT

OWASP Projects
Dave Wichers, OVWASP Foundation

Break - Expo - CTF

Flash Farameter Injection

Adi Sharabani 1B

Brain's hardwiring and its impact on software
develapment and secure software

Alexandry Bolboaca & Matia Diacony, Wosaic
YWiorks

Lunch - Expo - CTF

The Bank in the Browser - Defending web
infrastructures from banking mahware

Siorgio Fedon, Minded Securiy

Advanced Code Review Technigues - How to
Find Meedles in the Haystack Efficiently
Siddharth Anbalahan, Flnt & Jaideen Jha, Fint
OWASP ROI Optimize Security Spending using
CWWASE

Matt Tesauro, Texas Education Agency

Break - Expo - CTF

| thought you were my friend Evil karkup,
browser issues and other obscurities

Maro Heidetich, Business-TN

The Mew WWeh-Based Man-in-the-fdiddle Attack
Adi Sharaband, 180

Panel discussion

Moderator: the Panelists: thd




Eight Tutorials
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Hands on application security with the OWASP Live CD
by Matt Tesauro, Texas Education Agency

Web Services Security
by Dave Wichers, Aspect Security

Advanced Testing
by Michael Coates, Aspect Security
Web Application Security for Managers and Executives — The

Road Less Travelled
by Mano Paul, SecuRisk Solutions

Introduction to ModSecurity, the Apache Security Module
by Christian Folini, Netnea

Web 2.0 Hacking — Attacks & Countermeasures
by Shreeraj Shah, Blueinfy

Threat Modeling
by John Steven, Cigital

In-depth Assessment Techniques: Design, Code, and Runtime
by Pravir Chandra, Cognosticus

©




Krakow @ Day




Krakow @ Night




www.owasp.org/index.php/AppSecEUQ9
Registrations are




Thank You
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